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Abstract

Title : A Development Of Information System Of Runoff Data In Southern Part Of
Thailand

By : Mr. Natchanon Kaewdee
Mr. Pasit Dueansirirut

Mr. Chawanakorn Srisakda

Project AQVISOr & e
(Asst. Prof. Dr.Wisuwat Taesombat)
.......... VA A

The purpose of this study was to collect the runoff data from the Royal Irrigation
Department by 6 watersheds. Including Phetchaburi Basin , Prachuap Khiri Khan Coastal
watershed and basins in southern part of Thailand And create a database about runoff
with Information system on website by Adobe Dreamweaver CS6.This database including
Flow rates, Water level and Rating curve.

After that, Use the data to analyzed for analyze trend of water flow monthly and
annual flow. The west coast and the southern watershed in the east will select 6 stations.
Except Phetchaburi, South west coast And Songkhla basin will select 5 stations and the
Pattani river basin will be selected 4 stations. Selective distribution covers the watershed
area. look for an overview of the average flow monthly and annual flow of each
watershed.

The study indicated that Phetchaburi Basin Most of the monthly runoff will occur
during October. To November of every year. Annual rainfall is likely to decrease. West
Coast Basin Most of the runoff occur in October. To November of every year. October will
be the largest. Most annual runoff are likely to decline. East River Basin The monthly runoff
occurs in August. To November of every year. Most annual runoff are likely to decline.
south-western Basin Most runoff occur in September. To December of every year. Annual
runoff is likely to increase, considering the large number of dams in the south-western
watershed, which makes good water management. Songkhla Lake Basin Most of the runoff

occur in November. To December of every year. Annual runoff is likely to increase. And



the Pattani River Basin. Most of the monthly runoff occurs in May. To December of every

year. Most of the annual runoff is likely to increase.
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A1SRINTUNANILLILTNYeUS M8 ReULars18UYewEaNTInUIN  Taevinnls
Andenanidiniminfieduiunuvesquininesys  vellmsansiunn  neldkyTueen
AMaldramziunn neeaivaswal waztdannil lerasisallll

MINN 1 G UnYTy3

anl 94397 WUl
B.3A 2004-2015 anaa
B.8A 2003-2014 GIIGN!
B.9 2003-2014 GIAGN
B.10 1989-2015 Ana
B.11 2000-2004,2006-2015 g

M13199 2 duihweilaeiangiunn

annil %4990 WLy
Gt.9 1989-2015 BIAGN
Gt.10 1989-2015 anad
Gt.11 1989-2015 BIAGN
Gt.15 1997-2002,2004-2015 BIAGN
Gt.16 1997-2015 anad
Gt.17 1997-2015 BIAGN




M5 3 guinalaingJueen

a0l 4230 w2l
X.53A 1991-2015 s
X.64 1990-2009,2011,2013-2015 IR
K70 1989-2015 SR e
X.149 1988-2008,2012-2015 EIFE
X.158 1990-2015 EFIE
X.180 1995-1999 2001,2003-2007,2012-2015 Arad

M57 4 GaimelaauaIvan

A0 %4790 a7l
XATA 2004-2015 Wi
X.90 1988-2015 LT
%113 1989-2015 LT
X.17C 1989-2015 anad
W.2ART 2007-2015 GlIGE
H2T6 2009-2015 BlGEE




M519% 5 guthlamnil

annil 224U Wi lads)
X.40A 1989-2007 VAT
XTTA 1996-2005 13150
X.175 1990-1991,1996-2005 VAT
®. 1754 1997-2005 a4
a 8 Py o
15199 6 qummﬂimﬁmmumﬂ
011 24747 WLl
X.56 1988-2015 WT
X.150 1988-2015 VLT
X.187 1996-2008,2010-2015 WT
®.191 1997-2002,2004-2015 arnad
X.236 2004-2015 WT
2006-2011,2013-2015 arad

X.245

25
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[Hesnansaumadoyaiidesiinnugndeaaranuauysoivesdoya  153aldvions
psmapuATwanysaivosteyaluusazanvesquinnysy fuandumsa 7 quieeimea
pzTunn fauandlumsn 8 quinmaldtng fuoen duanddumsed 9 duiweiaauasan &
wanslumsed 10 fjuﬁ’ﬁjmmﬁ fauandlumsnedl 11 LLaxejmﬁmWﬂiél’qumi’uMﬂ Aauanalun1Ing
12

a 8 =
M1F19IN 7 Ej]llu’]LWsUiui

Uriildaya
ddu | aani WL Q RTC
1 B.1A 1989-2014 1990-1999
2 B.3 1988-2003 1988-2003
3 B.3A 2004-2015 2004-2015 2004-2016
q B.5 1989, 1991, 1996-2002 1991-1992,1994-1997,2010-2011

1989-1990, 1992, 1996-1997, 1999-2004, 2006-

5 B.6 1989-2014

2009
6 B.7 1989,1991,1996
7 B.8 1989,1991-1992,1995-2002 1989-2002
8 B.BA 2003-2015 2003-2015 2003-2015
9 B.9 2003-2015 2003-2015 2003-2015
0 B.10 1989-2015 1989-2015 1985-2015
1 B.11 1999-2015 2000-2004, 2006-2015 2000-2015

12 B.15 2006-2015




M35791 8 guthweilmziangJuan
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iffiﬁ%‘a:da
a6u anil WL Q RTC
1 Gt.1 1988-2013 - -
2 Gt6 1989-1993 1989-2003 -
3 GL7 1989,1991,1994-2015 1989-2001 -
4 Gt.8 1992-2105 1997-1998, 2000-2010 -
5 Gt.9 1989-2015 1989-2015 1980-2015
6 Gt.10 1989-2015 1989-2015 1980-2015
7 Gt.11 1989-2015 1989-2015 1980-2015
8 Gt12 1989,1991-2015 1989-1990 -
9 Gt.13 1989-1997 1990-2008 -
10 Gt.14 1989-1997 1989-1993, 1995-1996, 1999-2011 -
11 Gt.15 1989-2015 1997-2002, 2004-2015 1987-2002,2004-2015
12 Gt.16 1992-2015 1997-2015 1987-1988, 1997-2015
13 Gt.17 1989-2015 1997-2015 1987-1988, 1997-2015
14 Gt.18 1991-2015 - 1987-2015
15 Gt.19 1989-2015 1993-2014 1987-1988,1993-2015
16 Gt.20 2008-2015 - -
iy Ky.2 1989-2001 1989-1992, 1994-2000 1979-2001
18 Ky.3 1997-2013,2015 1997-2013, 2015 1997-2013,2015
19 Pr.1 1989-2015 - -
20 Pr.3A 1989-1998 - -




M5 9 guinalailngJueen

{f{ﬁfﬁéga
Rt anil WL Q RTC
1 b 1993 - -
1986-1992, 1995-
2 K104 2000,2002-2015 - -
5 X184 1989-1992 - 1959-1966
4 X.27 1995 - 1960-1975
5 X.35 1995 - -
6 K42 1988-1996, 1998-2001 - 1976-1988
7 .43 1988-1990 - 1982,1989
8 KA6A | 1988-1996, 1998-2003 - 1977-1984
5 1966, 1988-1996 , 1999-
X.53 2001 - 1971-1990
10 X534 1989-2015 1991-2015 1991-2016
11 X.54 1988-1996, 1998-2012 - -
1967-1981, 1989-2005, 2007, 2009,
12 .55 1988-2015 1989-1995, 1998-2007, 2009, 2012-2015 2012-2016
13 X.62 1988-1991 - -
1973-1988, 1990-2009, 2011, 2013-
14 X650 1989-2015 1988-2003 2016
15 K65 1988-1996 - -
16 X.70 1988-2014 1989-2009, 2012-2014 1967-1981, 1989-2009, 2012-2016
17 X.73 1982-1985, 1988-2015 1988-2005, 2007 1986-2007
18 X.98 1988-1996, 1998-2005 - -
19 X101 1988-1996 - 1976-1989
20 X.1024 1966, 1988-1996 1977-1989 1977-1989
21 X.103 1988-2012 - 1978-2009
22 X104 1988-2005 1988-2005 1978-2005
23 %105 1988-2010 1988-2008 1979-2008
24 X106 1988-2005 1988-1991, 1993-2005 1978-2005
25 X114 1988-1990 - -
26 X115 1988-1996 . _
27 X116 1988-1990 - -
28 X118 1988-1990 - -

28



Tiitd aya
a1 a0t WL Q RTC
1988-1993, 1996, 1999-
29 %119 - 1981-2013
2004 ,2011-2015

30 HKI1GA 1988-2015 1988-2015 1988-2016
31 %121 1988-2008 - 1981-2007
32 X122 | 1988-1996, 1998-2002 - -
33 X123 1988-1996, 1998-2001 - -
34 X125 | 1988-1996, 1998-2001 - -
35 X.138 1988-1996 - -
36 X144 1988-1996 - -
37 X149 1988-2015 1988-2008, 2012-2015 1984-2016
38 %152 1988-1996 - 1989
39 %154 | 1988-1996, 1998-2002 - -
40 X.154-1 2000-2001 - -
a1 X158 1988-2015 1990-2011 1990-2016
42 %159 1988-2002 1988-2002 1984-2002
43 K594 2003-2009 2004-2006 2003-2006
a4 X160 1988-1990 - -
. 1988-1991, 1996, 1998-

X161 2006 - ,
a8 X164 | 1988-1996, 1998-2001 - -
a7 X.165 1988-2012 1985-2009 1989-2009
a8 X166 1988-1996 - -
49 X167 1988-2015 1590-2009, 2012-2015 1989-2016
50 X.168 1988-2009 1988-2007 1987-2007
51 X.169 1988-1996, 1998-2002 - -
52 X171 1988-1990, 1993-2002 1996-2002 1996-2002
53 *179 1991-1996 - ,

1995-1999, 2001, 2003-2007, 2012-2015

54 X.180 1989, 1992-2015 1995-2001, 2003-2007, 2012-2016
55 X.182 1993-2002 1996-2002 1996-2002
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gy
Unuvaua

Ay aanil WL Q RTC
56 X.183 1993-2002, 2004 1996-2000, 2002 1996-2000,2002
57 K834 2004-2005 -
58 X.184 1995-2015 1996-2002 1996-2007
60 X.199 1999-2005 1999-2005, 2010-2011 1999-2005
61 X200 1999-2015 2006-2008, 2014-2015 2006-2008,2013-2016
1989,1999-2005,2007-
62 X201 2012 1990-1998
63 X.201A 2009-2015 2009-2012 2009-2012,2015-2016
64 X.202 1999-2005 -
65 X.203 2000-2015 2000-2009, 2012-2015 2000-2009,2012-2016
66 X211 1999-2001 -
67 H211A 2009-2012 -
68 X.212 1999-2015 2004-2007 2004-2007,2015--2016
69 X.213 1999-2015 2004-2010 2004-2010
70 X214 1999-2005,2009-2015 2004-2010 1959-2010
71 X215 1989,1999-2005 1999-2004 1999-2004
7z X.2154 2009-2015 - -
73 X218 2003-2005 2003-2004 2003-2004
7 X219 2000-2001 - -
75 X.220 2000-2002 - -
76 X221 2000-2005 - -
7 X222 2000-2002 - -
8 %223 2000-2001 - -
79 x.224 2000-2001,2005 - -
80 X.232 2003-2005 - -
81 x.244 2003-2010 2004-2007 2004-2007
82 X.247 2007-2014 2007-2011, 2013 2007-2011, 2013
83 %.248 2006-2015 2006-2015 2006-2016
84 X270 2009-2012 2009-2012 2009-2012
85 X271 2009-2010 - -
86 %.274 2012-2015 2013-2015 2013-2016
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Uiifidaya
18U annil WL Q RTC

1 X.44 1988-1996, 1998-2015 1988-2015 1967-1988, 1999-2016
2 X67 1988-2004 1988-2003 1967-2003
3 X.6TA 2004-2015 2004-2015 2004-2016
4 X.68 1988-2015 1989-2015 1967-2016
5 1967-1971, 1975-1982,

X.69 1988-1996, 1998-2001 1967-1968, 1970-1971, 1978-1981 1967-2006
6 X.69-1 2000 - -
7 X.71 1988-2002 1988-2000 1967-2000
8 X.T1A 2002-2003 2002-2003 2002-2003
9 X.71B 2005-2015 2005-2009, 2014-2015 2004-2009, 2014-2016
10 X.83 1969-1996, 1998-2001 - -
" 1988-1989, 1991-1996,

X & 1999-2008, 2010-2011 - -
12 X.86 1988-1996, 1999-2002 - -
13 X.87 1988-2001 - -
14 X.88 1988-1989, 1991-1996 - -
15 *.90 1988-2015 1988-2015 1971-2016
16 X91 1988-2010 - -
17 %.109 1988-2015 1988-2007, 2012-2015 -
18 X111 1988-2010 1988-2008 1979-2008
» 1988-1996, 1998-2002,

X112 2006-2015 1988-1996, 2006-2015 1979-2016
20 X113 1988-2015 1989-2015 1979-2016
21 X.129 1988-2006 1988-2005 1983-2005
22 X.131 1988-1989 1988 1983-1988
23 X141 | 1988-1996, 1998-2005 1988 1983-2005
24 X.161-1 2000-2001 - -
25 X142 1988-1989 1988 1983-1988
26 X145 | 1988-1996, 1998-2001 1988 1983-1988
27 X.165-1 2000 - -
28 X.155 1988-1996 - -
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Viididiaya
Ul annil WL Q RTC

29 X156 | 1988-1996, 1998-2002 - 1984-1985
30 X170 1988-2015 1989-2015 1988-2016
31 X172 | 1989-1996, 1998-2002 1989-2002 1988-2002
32 X173 1989-2005 1990-1991, 1993-2005 1990-2005
33 XAT3A 2006-2015 2006-2015 -
34 X174 | 1989-1996, 1998-2015 2003-2015 1990-2016
. 1993-1996, 2000-2002,

X.181 2007-2012 1989-1995,1997-2015 -
36 X.181A 2003-2005 1989-1990,2001,2007-2008 -
37 X194 1998-2007 1990-2008 -
38 X240 2004-2012 2004-2012 2004-2012
39 X.253 2006-2012 - -
40 X.265 2007-2015 2007-2008 2007-2008
41 X.266 2007-2015 2007-2011, 2013-2015 2007-2016
42 X.267 2007-2015 2007-2015 2007-2016
43 X.269 2009-2012 - -
44 X.276 2009-2015 2009-2015 2009-2016
45 X277 2009-2012 2009-2012 2009-2012
46 X.278 2011 - -
47 X.279 2011-2015 - 2012-2016




M57191 11 guirdaeni

ﬂﬁi%’a:ﬂa
ety annil WL Q RTC
1 X.40 1975, 1983-1987 - 1964-1984,1989
2 X.A0A 1988-2013, 2015 1989-2007 1989-2007
3 X.40B 2003-2015 2003, 2006-2007 2002-2007
q X.45 1988-1989, 1991-1995 1988-1989, 1991-1995 1982-1995
5 X2 1993 - 1967-1979
1988-1995, 2004, 2012-
6 X7 2015 - -
7 KTTA 1995-2005 1996-2005 1996-2005
8 X.T9 1988-1996 - -
9 X.175 1990-1992, 1994-2002 1990-1991, 1996-2002 1990-2002
10 X.175A 2003-2005 2004 2004
11 KPAT 1998-2002 2001 2001
a S Py )
MI1F19N 12 qummﬂlmﬂammum
Uiiidays
v aanil WL Q RTC
1988-1996, 1999-2003,
1 XA47 - -
2006-2014
2 X.48 1993 - -
3 X.49 1988-1996, 1998-2001 - 1967-1968, 1983-1989
4 X.49-1 2000-2001 - -
E X.56 1988-2015 1988-2012, 2014-2015 1966-2016
6 X.107 1988-1996 1988-1989 1978-1989
7 X.109 1988-2015 1989-1995,1997-2015 1979-2016
8 X110 | 1988-1996, 1999-2001 1988-1989 1979-1989
9 X.126 | 1988-1996, 1998-2001 - -
10 X.127 1988-1996 1988 1986-1989
. 1988-1999, 2006-2012
X.128A | 1988-2002, 2006-2015 1984-1985, 1987-1999, 2006-2012
1967-1981, 1989-2005, 2007, 2009,
12 X132 | 1988-1996, 1998-2001 - 2012-2016
13 X133 | 1988-1996, 1998-2001 - 1986-1989
1988-1996, 1998-2001,
14 X.137 2000-2005 1988-1989 1986-1989

33



Rl annil WL Q RTC
15 %139 1988-2012 1988-2007 1983-2007
16 X.139A 2009-2015 2009-2015 2009-2016
. 1988-1996, 1998-2001,
%.143 2003-2005 - 1986-1989, 1991-1994
18 X.148 | 1988-1996, 1999-2002 - -
19 X150 1988-2015 1988-2002, 2004-2007, 2009-2015 1984-20156
20 X.153 | 1988-1996, 2000-2001 - -
21 X.157 1988-1996, 1999-2001 - -
22 %.185 1997-2001 - -
23 X.186 1997-2015 2003-2009, 2013-2015 2003-2016
24 X.187 1996-2015 1996-2008, 2010-2011, 2013-2015 1996-2016
25 %.188 1988, 1997-2012 - -
26 X.188A 2009-2015 2009-2011, 2013-2015 2009-2011, 2013-2016
27 %.189 1997-2012 1997-2008 1997-2008
28 X.189-1 1998-1999 - -
29 X.190 1997-2001 1997-2001 1997-2001
30 X.190-1 1998-1999 - -
31 %.190A 2005-2015 2005-2011, 2013-2015 2005-2011, 2013-2016
32 X.191 1997-2015 - 1597-2016
33 X.191-1 1998-1999 - -
24 X.192 1997-2012 1997-2008, 2010-2011 1997-2008, 2010-2011
35 X.192-1 1998-1999 - -
26 X193 1997-2005 1998-2004 1998-2004
37 X.196 1998-2012 2003-2011 2003-2016
8 X.204 2003-2014 2003-2009 2003-2009
39 X.205 2003-2012 - 2003-2008
40 X.206 2003-2012 2003-2008 2003-2009
41 X.207 2003-2012 2003-2007 2003-2007
42 X.208 2003-2012 2003-2007 2003-2007
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TJﬁ‘ﬁ“ﬁ’a.,"Jla

19 anil WL Q RTC
43 X.209 2004-2014 2005-2009 2005-2009
44 X.210 2003-2005 - -
45 X216 2003-2005 . }
46 X228 2003-2012 2003-2012 2003-2016
a7 X.229 2003-2015 2003-2012 2003-2012
48 X230 20032015 - -
49 X231 2003-2012 2009 2009
50 X.231A 2011-2015 2012 2012
51 X233 2004-2012 2004-2007, 2009 2004-2009
52 X.234 2004-2015 2004-2014 2004-2014
53 X.235 2004-2013 2004-2012 2004-2012
54 X.236 2004-2015 2004-2009, 2013-2015 2004-2009, 2013-2016
55 X237 2004-2015 2004-2011 2004-2011
56 %.238 2004-2012 2004-2011 2004-2011
57 %.239 2004-2015 2004-2008, 2010-2012 2004-2012
58 %.245 2006-2015 2006-2011, 2013-2015 2005-2011, 2013-2016
60 %261 2007-2015 2007-2015 2007-2016
61 X.262 2007-2012 2007-2012 2007-2012
62 %.263 2007-2012 2008-2009 2008-2009
63 %279 2011-2015 2012-2015 2007-2012
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LONE1591999

msadradumadaelusunsa Adobe Dreamweaver CS6. uvidsfisin:
http://www.krusriwan.com/data/dreamtopic2-1.html, 6 dgu1eu 2561.

Aty I1Uila. 2543 msﬁﬁuuﬂauLwaé'hqun"31/|mﬁ’m%'mzuuﬁﬁﬁummjaazjuLujﬁﬁ
Naa4 (Development of Homepage for Hydrological Characteristics of  Mae
Klong River Basin for Mae Klong Internet Information Server). 1A5$u3enssu
AAIPNIAINTIUNVAUILINUY URINGISUAYATANENT INSUVAATLAWILLEU.

dinaurausenudl 15 nsensaunuasuaravinsal. 2559, Uwin. undsiiun:
irrigation.rid.go.th/rid15/learning%20corner/activity/report.doc, 5 fgungy
2561.

99 WTANEITUY wagAUdUY. 2559. msﬁ'sumszwmiauLVlﬂﬁi'iaanjaﬁ'wiﬂufcjuﬁwaq
Uszmalng. 1A53993ANI50 AAITIAINTSUYAUTENIY UNINGIAENEATANERNS
ANYIUANTLNIE.

Yueatly AAsy. n1sadraiumanlslusunsy Adobe Dreamweaver CS6.
LARINLN:
https://krupiyadanai.wordpress.com, 6 iqu1gu 2561.

Aot sauMANI N N LAENIiNYes. 2555, nMadidunisiiunsTauTiteyauas
Ainseidoyalassnisianszuuadedaya 25 guiuasuuudiaasiviautiuga,
uaTIN:
http://www.thaiwater.net/web/index.php/knowledge/128-hydro-and-
weather/663-25basinreports.html, 2 figuigy 2561.
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Dreamweaver 148y

Adobe Dreamweaver ﬁa?j‘alﬁmﬁa Macromedia Dreamweaver LJulUsunsy
wAly HTML Wsunlngusen Macromedia (J930uAuAian1ssiuiuusen Adobe system)
Adobe Dreamweaver LHulusunsudnfasuiilidmivairaivled lnsanunsofiezesniuy
WanndulenlalnensideulanHTML nieldiadesiiolulusunsy Adobe Dreamweaver &3a
FruasralanHTMLIMS nednlusTd Tneauisairdennuwazatnanuseneuundivinale
9813418 9 Loy mmaameamaumamumamumEJmaamummmmaﬂumumauammimw
uaﬂmﬂuumamwszma]vaswmimamimﬂumwamu,avmsua:uamﬂmusuamaimlmaamms
WWaulAn Server Script LWiumI‘UiLmimuaiwiﬂmiﬁimamium NS VLN RAIU
Sulsrsausilolmiluaudesioadn

o [ < 3
AsnIualasesIwI vl
° | & < a 1 ¢ o PP Y
1.yinseanwuvadinysenaunanuavasiuledlasAninivlefnarnunasinng
wiazurtnaziiilonosls Wevumavdiuazidauleanuaenals
2. asnalnawmesvannianawmes Lﬁaisé’féfw%’uLﬁULaﬂamLazgﬂmwﬁaﬂi’ﬂuﬂﬁ
o & ¢ o ¢ v & a o o ¢ o A4 &
BnAuled Tagvinniswenlnamasgesldlmduszidou wazn15asalnatnasAl5ataLdy
AN1ING Y
o w gj a ) @ & v ) LY =1
3. vAamgunmuazienansiavaanagldlunisiivledudinnistuiinasly
WawasilbmwsaulilAseuses

v I3
Ansadrelad

a dl . .
Laanvuy Site > New Site
DW File Edit View Inset Modify Format Commands | Site | Window Help ENv £y S
Untitled-1 x | New Site...

Code ‘ Spiit @ Live ’Tﬁv &L M. e = MNew Business Catalyst Site...

Manage Sites... -

| Get Ctrl+Shift+D
Check Out Ctrl+Alt+ Shift+D
Put Ctrl+Shift+U
Check In Ctrl+Alt+Shift+L
Undo Check Out
Show Checked Out By...

Locate in Site

Reports...
Site-Specific Code Hints..

Synchronize Sitewide...

Check Links Sitewide Ctrl+F8

ANA 15 nsasales
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2 ynseaanlos

2.1 N5t anazidandunuangasnisamiu 1id1usu save nd

Site Setup for index >
Site . _ _
ADr site is a collection of all of the files and assets you use in your
Servers Mo -
- . ADr site usually has two parts: a lecal folder on your
Version Centrol comp where you stere and work on files, and a remote folder on a server
»  Advanced Settings where you post the same files to the web.

Here you'll select the local folder and a name for your Dreamweaver site.

Site Name: ‘ index |

Local Site Folder: ‘ D:\websitel, | =

T

A 16 nssaanled (1)

'
a

2.2 Click 7 Advanced Setting > Local Info 7i Default Image folder Tiaanlnainasa
foINaAiugunIm anlunaly Save

Site Setup for index

Site
Default I folder: | D:\websitel
Servers ault Images folder: [D:\website{mage | &
Version Control Site-wide Media Query file: | | &
v Advanced Settings
Local Info Links relative to: (s) Document () Site Root
Cloaking

Web URL: [http:// |

Enter the Web URL if you dont have a remote server defined. I
you have a remote server defined, Dreamweaver uses the Web
Contribute URL specified in the server settings.

Design Notes

File View Columns

Templates

Spry
Web Fonts

[[] Case-sensitive links checking

[¥] Enable Cache

The cache maintains file and asset information in the site. This
Speeds up the Asset panel and link management features.
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1. ﬂaﬂﬁl,mé Modify > Page Properties N%11¢114 Page Properties 4%
wisneazideneaniu 6 el

1.1 Appearance (CSS)
\unsimuanaauiimlisemdniumg daeg CSS

Page Properties

Category Appearance (C55)
A;pearance L}, Page font: | Default Font «| B F
Links {C385) _
Headngs (CS5) Sizei px
Title/Encoding
Tradng Image Text color: m I:I

Background color: m I:I

Background image: | Browse...

Left margin: |:| px Right margin: |:| px
Top margiri: l:l px Bottom margin: I:I px

Help Cancel Apply

Al 18 nsmmuanuaudany Appearance (CSS)
finieing Page Properties AunsaAvuARuENURRAN 9 Y83 Appearance (CSS) el
Page font: fiMuuAsULUUYBIMIBNYS
Size: MNUATUIAVDIAIDNYT
Text Color: AMUARYDIRIENBT
Background Color: Svusditundweaiume
image: Amunawliduitundwosiume
Repeat: MAUANTSLARITIVDINNALNG
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Left Margin: fWuAsSYe¥YaUmMUEevauIumng
Right Margin: fyuATEeLI0UMUTINUDLIUING
Top Margin: fUUATEYLUBUMUULUBLIULNG
Bottorn Margin: fVUASEEUBURTUANUBLITULNG

1.2 Appearance (HTML)
inupaaaudRallvemiiuma she HTML

Page Properties
Category Appearance (HTML)
% Background image: | | Browse. ..
Hggsdi{ncgsss(}l;ss} Background: Ql:l
%‘Z’Eg”'}fnda'zge Text: [ | visitedlinks: [ [ |

Links: Q l:l Active links: Q I:I

Left margin: I:I Margin width: I:I
Top margin: I:I Margin height: I:I

Help Cancel Apcly

Al 19 nsmmuaAMauURniY Appearance (HTML)

finieing Page Properties #unsaAmuaRuENURANY 9 U89 Appearance (HTML) geradd

Background Image: svunnnliduiundsveaiuma

Background: Asunditundwesiuime

Text: AMRUARUDIAIONYT

Visited links: mMuungasden Lﬁagmmﬁﬂaﬂlﬂué’a

Link: fvuadvesteruiiugadsd

Active links: MuunduDIasA Lﬁagmméﬂéﬂ

Left Margin: fWUASYELYBUATUGIEVDLIUNT

Right Margin: fuATEeEUaURUIVBLIUNG

Top Margin: MUUATEEZVOUATUUUTBLIUNG

Bottom Margin: fAUATEELUBUATUANTDIIULNA
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o =

UAugIuveansasagaiiasleallinks)

Category

Appearance (CS5)

Appearance

Headings (CS5)
Title/Encoding
Tracdng Image

L

Links (C55)

visted finks: [ [ ]

Underline style: | Always underline

Help

Link font: | (5ame as page font)

v B s

Link color: Q I:l Rollover links: E I:I
Active links: E I:I

Cancel Apply

d' ° wa Y =
AINN 20 ﬂ’]'ﬁﬂqﬁu@]ﬂ'mﬁlﬂmsﬂ@ﬁﬂ'ﬁai']ﬁi]ﬁmlfﬁamiﬂq

vineing Page Properties aninsamvuaRaaudfsing 9 ves nsaseqateules

Link Font: fMvuagUiuuvesderuiildiduiad
Size: fPUATUINVDIVDAINN T TURIA
Link Color: Auunguastannunldidudae

Rollover links: Myundvastonuadan ogniundy

1%

Visited links: Mvuadvestonudad Wegnundadnluue
Active links: fiviuadvastanuaen Weagnundaan
Underline Style: Myvuaguuuunstiaiduldvesdoninudad
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& ° va v g v o A v &
LUUﬂqﬁﬂqVUW?‘jmau‘UWGUQWUWNWISULUUM'JLiaQeLUMuf]L'JULWQ

Category Headings (CS5)
QEE:::::EE: EEFSI'I?‘I)L) Heading font: | (5ame as page font) ~ | B 7
L feos Heading 1: px El:l
E'ﬂa?:‘rlsgclfndagge Heading 2: px El:l

Heading 3: px El:l

Heading 4: px El:l

Heading 5: px El:l

Heading &: px El:l

Help Cancel Apply

A9 21 MsfvuaauatRTenUTIEes

Inieing Page Properties aunsamvunraautfaig o vasdenuiiizadle

De
=De

Heading font: AMMuAFULUUAIBNYIVDITILTEY

Heading 1-6: AMMUATUIALALEFIONYIVDIAILTOY

1.5 Title/Encoding

Junsimuanaauifveaniiume

Page Properties

Category

Title/Encoding

Appearance {C55)
Appearance (HTML)
Links {C55)
Headings (C55

Tracing Image

Title:

Document Type (DTD):

Encoding:

Unicode Normalization Form:

| Untitled Document

¥HTML 1.0 Transitional ~

Unicode (UTF-8) w Reload
C (Canonical Decomposition, follow ~

[Jincude Unicode Signature (BOM)

Document folder:

Site folder:

Help

D:website,

Cancel Apply

Al 22 nsimueannantRvemtiumg
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fintieing Page Properties anunsairuaRENTRne o vasmtIunale ail
Title: fvuaderisasaaiumg

Document Type (DTD): AUAUTELANYDIATI UG

Encoding: fmunmwiiagldluiums @eouruuady Unicode (UTF-8))

1.6 Tracing Image
Hunisinunauanifvesgunim

Page Properties

Category Tracing Image
Appearance {CS5) o
Appearance (HTML) Tracing image: Browse. ..
Links {CSS)
Headings (CS5) Transparency: 100%
Tlﬂei'EncodinE
Transparent Opaque
Help Cancel Apply

AW 23 MsmvuaauEtRveagunw
ntieing Page Properties @nunsarimunraaudisng q vesgunnlasail
Tracing image: fvualndnniagldidunuu
Transparency: Usunasanulusslaussnin

mMsdaguuuudannuuuiumwg

LnsAmuagULuumMonys
1.1 naidendomuiifesnmsimuaguuuuiasngg
1.2 i Properties aaniden CSS fannd 23
1.3 4 Targeted Rule l@®n New Inline Style
1.4 pdniden Font 7ifaenis
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= = - Default Font
autheela Verdana, Geneva, sans-serif

- Georgia, Times New Roman, Times, serif
_ X nsansiuan Courier Mew, Courier, monospace
“ 3 Arial, Helvetica, sans-serif

aAuhanatada

Ariuaan

i Times New Roman, Times, serif

dunhmziasu Palatino Linotype, Book Antiqua, Palatino, serif
AR Lucida 5ans Unicode, Lucida Grande, sans-serif

MS Serif, New York, serif

Lucida Console, Monaco, monospace

<body> <div#apDiv7> <p> Comic Sans MS, cursive

Properties
{PHM. | TargetedRule | <NewInline Style>  ~
B css Editfue | CSSPand |

oma, Geneva, s: f
Trebuchet M5, Arial, Helvetica, sans-serif
Arial Black, Gadget, sans-serif

(Ve a [o0% | o @ W

Edit Font List...

Font E!‘T:u\tF(wnt
e e[|

ANN 24 NSMMUATULUUAISNYS

2. ANSAAUATUIAGIDNYST
2.1 ﬂmLﬁaﬂ%’ammﬁﬁmmiﬁmumgﬂuuu@hé’ﬂm
2.2 i Properties pdnidan CSS fanmil 24
237 Targeted Rule L@9n New Inline Style
2.4 9 Size ﬂamﬁaﬂﬁummﬁéf@qmﬁ

<body> <div#apDiv7> <p>
Properties
<7 HTML Targeted Rule | <Mew Inline Style:> ~

B css Edit Rule €55 Panel
U 2

AINA 25 NNSINAUATUIAGIDNYS

3.N159AF L AUIYBAINY
3.1 101 cursor Tnslnsssumisussiiniisosnissnsunistonny
3.2 Adn Format > Align
3.3 Fendaruvistoaruiidesnis @adne fenans Fawan)
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Uszunnvashidsunmimunzaulunisthunldasdulvduivana sif w3e jpg

wazawinvedlagunmlimsuinauiulasiienvuialivinsauneuinanldnu

1. 11 cursor Wandbinseiuvusiisaenisasldsunm

2. 9 Insert Panel Aaniaan Common > Images

3. Fenlawmesiiugunim > adnidengunwiidesnis > natu OK

4. fuiidenuiteaiutegunm > natu OK

Adobe ErowserLab

Insert | M| v=

(] =
Common ¥

'@ Hyperlink ﬁ: €SS Styles
=7  Email Link T ;

.& Mamed Anchar

Business Catal
Harizontal Rule m fess et

i
IFEl Table E I__"E

Insert Div Tag =

@ - Images : Image

@ - Media
& widget
Date y

Select Image Source

Select file name from: (@ File system Site Rook
(0 Data sources Server... Image preview

Look in: | image \,‘ G 1- Y -

"
. é{; . j = . ‘
i pii 12.png 13.png 3609 1 2481 PHG, 481K /4 11

W

File name: |1}E.png | I QK

Files of type: | Image Files {*.gf;"jpa;" jpeg;” png;" psd) ~ Cancel

URL: [File: /D1 websie/mage/0.png |

Relative to: Document | Untitled-1

Change default Link Relative Ta in the site definition

Document should be saved to uge this option, Preview images
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Fugniteldluns Layout Tutes
1. 11 cursor TUelinsasuniafisoanisazasnemnsns
2. and Insert > Table WLUAAITAITININT 26

Table size

Rows: Columns:
Table width: pixels ~

Border thickness: El pixels
Cell padding: El
Cell spacing:
Header
L L1 ] L L1 ]
[ =
I=i=i= -
Top Both
Amcessibility
Caption: | |
Summary:
Help oK Cancel

A 27 nnsdednnslamssluume
fintineng Table anansafvunAuaNSAss q vasmnsldsed
Rows: Tdd1u2uuaImuA8InIs
Columns: T@ag1uIuABANLANADINTT
Table width: AM%UAAIUNTINVDIRITI
Border thickness: MUUAAIUNUNIVDUEUVOUNITS
Cell padding: fmunssezvisszriveumssiuilemaeluged
Cell spacing: ANUATEELUINTEIINUTAALARZLTAE

nsiaule L IumWa

nmsifenles (Hyperlink) Aon1sifienlesiusyninaiuimaarnuimilsludedn
wiwilwitennganiineglundifediunisienlesdissdusznousy 2 dwumeriu Ao Aunia
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Tupaulunisteulawiuing
1.AANLEABNTDAINUNABINITAS 19N DU
2.9 Insert Panel > Common > Hyperlink 2zUananiina1sUuNIAInIng 27

Hyperlink
Text: “_ ‘
Cancel
Lirk: ‘ v ‘
= Help
Target: ‘ i

Title: ‘ ‘

Access key: I:l
Tab index: I:l

AT 28 RHIENe Hyperlink
neing Hyperlink anansamvunauaudisng  veinstouleslanall
Text: dwsuiiunvanuesuIeanfoiNseules
Link: @onsunislnansesnisuazidenlvansesnisivesinnisiioules
Target: lonnsuaninavosi muendesn1sasil

_blank wansJumavantemsluniamsuil nsalldoumsy
_new wanaTumatanenialumtinaslml

_parent wanaiumavaemalumsuiiaseuisuiiagtiueg
self wansiumavanemslumsudenfunisdeles
_top wanaIuNaUan e luntAN AL UUANWENA

Title: AuRUaAURFBINITIWLaAilotn cursor lUnalinsesunusnidaules
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1. mygnlnaaruus iwes
2. Msdnlranniglusunsu Adobe Dreamweaver
3. mysninandaelusunsy FTP dudulusunsutiglunissnlvan

Tunflaznannanisenluanduladselusunsy FTP d9lUsknsy WinSCP)

1. WoUa g ulUsuN UL LAAINUNANTUNSINING 28
| B

d’ New Site Session

File protocol:

SFTP ~

Host name: Port number:

| | 2]
User name: Password:

Save hd Advanced... |v

Tools - Manage - Login Close Help

N7 29 nenenadlalduluswnsy WinSCP

?fwzéfmﬁwmiﬂiamﬂaﬁqgﬂﬁ14ﬂ.9‘1”q1‘f

File protocol: gﬂLLUUGUENL%%WL'J@%ﬁstzL%"fLﬂm \Wu FTP |, http , SFTP

Host name: Tdnneiavlefivosa3as Web Server

Port number: dn8lavdR U1 lUsugsniaes

User name: Id%a;ﬂ%mu

Password: lasasu
2. s upload 1denlwddeyannils Local Host (awnesiduiinlidildlunisairaiules
wavun) Tugails Remote Host

3. Wenan1snisianldanu WinSCP Tiadniiuy Session wagidan Disconnect
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